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Introduction

Numerical analysis of cable systems is an active field of study. It is not only dominated by 
scientific insight, but also engineering practice and numerical considerations. Production 
cost plays an important role, and so does durability. The cable industry tends to be on the 
conservative side — and for good reasons; replacing a faulty submarine cable can be 
extremely costly1. The typical design may last for over forty years. To make sure one gets 
a good return on investment, the industry has been relying heavily on rules of thumb, 
safety margins, life-cycle analysis, and international standards such as the IEC 60287 [1].

Figure 1: The volumetric loss density in the screens and the armor of a three-core lead sheathed 
XLPE HVAC submarine cable at a nominal phase temperature of 90°C.

In the meantime, however, computational resources have increased drastically. When 
investigating research on the matter [2, 6], one cannot help but notice a strong correlation 
between the year of publishing and the level of detail present in the numerical models. In 
particular the introduction of twisted periodicity [2] and short-twisted periodicity [3] has 
been of great significance: Fully detailed 3D cable modeling is now possible within 
minutes on relatively cheap hardware (rather than hours, on cluster systems).

As a consequence, traditional methods and safety margins are being questioned: 
Numerical research is pushing the industry to find more cost-effective solutions.

1. Up to several hundred million US dollars for a replacement, and tens of millions of dollars for a repair.
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Tutorial Series Overview

This tutorial series discusses the capacitive, inductive, and thermal properties of a three-
core, lead sheathed XLPE HVAC2 submarine cable. It has a main conductor cross section 
of 500 mm2, a phase-to-phase voltage of 220 kV, and carries a nominal current of 655 A.

The series is written in eight chapters (as summarized on the following pages), starting 
with the fundamental principles in 2D. In a systematic fashion it deduces and proofs what 
cable experts already know — as a form of validation — and then continues to increase 
the complexity to a point where 2D models are no longer sufficient.

Apart from discussing cable related topics such as charging currents, bonding types, armor 
twists, and temperature dependency, a lot of attention is given to electromagnetism and 
numerical modeling in general. This includes the importance of certain material properties 
and geometric features, ill-posed problems, weakly coupled systems, verification, and 
simplification.

Note: Although this tutorial series investigates a specific kind of submarine cable, many 
of the discussed topics apply to terrestrial cable systems just the same. In fact, some of 
the treated topics (such as cross bonding) are included specifically because they are of 
interest for cable systems in general, not so much for submarine cables in particular.

A  N O T E  O N  E D U C A T I O N A L  V A L U E

Although this tutorial will be of particular use for those working within the cable industry, 
it is not all “just about cables”. This tutorial — and the entire series, for that matter — is 
about Electromagnetics, and Numerical Analysis. It is about good engineering practices, 
about understanding and applying theory, about result validation, and about presenting 
your results in an attractive and informative way.

The three-phase cable with the magnetic, twisted armor is and ideal device to illustrate and 
investigate various electromagnetic and numeric phenomena. Since many of these cables 
are standardized3, their physical properties are available from literature (allowing for 
validation). At the same time, they are a part of ongoing research. This makes them a 
suitable tool for industry professionals and academic students alike, to familiarize 
themselves with the numerical analysis of electromagnetic devices in general.

2. Cross-linked polyethylene, high-voltage alternating current.

3. They are typically based on IEC 60287 or similar standards.
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Note: At this point it may be tempting to skip to the 3D part of the tutorial series 
directly. It should be noted however, that many of the cable’s aspects can be understood 
and investigated perfectly fine with 2D models alone. The computational cost of a 2D 
model is negligible compared to 3D. When in doubt, start in 2D.

S U B M A R I N E  C A B L E  1  —  I N T R O D U C T I O N

The model that results from this tutorial serves as a template for chapters 2, 4, and 6 (the 
Capacitive, Inductive, and Thermal Effects tutorials). It contains a detailed 2D geometry 
of the submarine cable, along with a mesh. Some parameters, selections, and materials are 
prepared as well. The corresponding instructions start in section Modeling Instructions 
(Introduction Tutorial).

Figure 2: The cable’s 2D geometry, including the three phases (with screens) and an armor.

Experienced COMSOL users with little or no interest in these topics — geometry, mesh, 
selections, and such — may choose to skip this part of the series and continue with one of 
the following tutorials. When you are new to COMSOL Multiphysics, however, it is 
worthwhile to take some time for this, as it will help you to familiarize yourself with the 
basics.
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S U B M A R I N E  C A B L E  2  —  C A P A C I T I V E  E F F E C T S

Figure 3: The real part of the electric potential distribution at phase .

The second chapter uses the 2D geometry from the introduction tutorial to investigate the 
cable’s capacitive properties. It validates the assumption that for the capacitance and the 
charging currents, analytical approaches are sufficient (verification is included).

The influence of material properties, the cable’s length and bonding types is discussed. 
The model justifies the approach chosen in subsequent tutorials in this series, most 
notably, the Bonding Capacitive and the Inductive Effects tutorials (chapters 3, and 4).

Included Topics
• Using the Electric Currents interface: Current Conservation, Terminal, Ground... 

Extracting lumped quantities using the terminal feature.

• Comparing a numerical model to an analytical one. Comparing displacement- and 
conduction currents. Checking the risk of electromagnetic breakdown. Checking the 
conditions on the floating end of a 10 km long cable with single-point bonding applied.

• Using expressions such as exp(-120[deg]*j) to set a phase difference in the frequency 
domain. Reflecting on the applicability of the used partial differential equations 
(whether it is safe to assume the in-plane electric fields are curl-free).

• Reflecting on the relevance of certain details in the model. Discussing the large material 
contrast (conductors and insulators) and how this affects numerical stability.

ϕ 0°=
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S U B M A R I N E  C A B L E  3  —  B O N D I N G  C A P A C I T I V E

Figure 4: The charging current that builds up in the lead sheath (in case of cross bonding).

Based on the results from the Capacitive Effects tutorial, it is justified to neglect the 
capacitive coupling between the screens and consider one single isolated phase, together 
with its screen. As opposed to the Capacitive, Inductive, and Thermal Effects tutorials, 
this tutorial uses a 2D axisymmetric geometry representing the entire 10 km of cable.

For several bonding types, the build-up of charging currents and the corresponding losses 
in the screen are analyzed (verification is included). The model validates the assumption 
that the high phase potential induces a uniform charging current — one that barely 
depends on the screen potential — and so justifies the approach chosen in the Capacitive 
and Inductive Effects tutorials (chapters 2, and 4).

Included Topics
• Using the Electric Currents interface: Current Conservation, Electric Potential, Ground... 

Determining the total loss in a system by means of a volume integration.

• Using a 2D axisymmetric geometry. Using scaled coordinate systems to make extremely 
long geometries manageable. Using an anisotropic conductivity to stabilize a model.

• Discussing several bonding types: single-point bonding, solid bonding, and cross 
bonding, and reflecting on how they affect the build up of charging currents. 
Comparing a numerical model to analytical ones (one for each bonding type).
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S U B M A R I N E  C A B L E  4  —  I N D U C T I V E  E F F E C T S

Figure 5: The instantaneous magnetic flux density norm when the armor twist is included.

Results from the Capacitive Effects and Bonding Capacitive tutorials show there is only 
a weak coupling between the inductive and capacitive phenomena in the cable. In addition 
to this, research [2, 6] suggests 2D and 2.5D inductive models are able to provide a good 
approximation of the cable’s lumped quantities, and at only a fraction of the computational 
cost (as compared to long 3D twist models).

This justifies a 2D/2.5D inductive model that includes out-of-plane currents only. The 
model demonstrates methods suitable to approximate the armor twist, as well as certain 
milliken conductor designs. It serves as a basis and a reference for the Thermal Effects 
and the Inductive Effects 3D tutorials (chapters 6, and 8). Verification is included; the 
results are compared to the cable’s official specifications.

Included Topics
• Using the Magnetic Fields interface: Ampère’s Law, Coil (group), Magnetic Insulation... 

Exciting a 2D/2.5D inductive model by means of the Coil feature.

• Using a Coil group to model the armor twist (useful for cross bonding too). Using the 
Homogenized multiturn setting to approximate a milliken conductor.

• Advanced postprocessing. Analyzing and verifying results, investigating the differences 
between the Plain 2D, 2.5D and 2.5D + milliken configurations. Reflecting on the 
difference between the AC- and DC resistance.
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S U B M A R I N E  C A B L E  5  —  B O N D I N G  I N D U C T I V E

Figure 6: The magnetic flux density norm in a simplified geometry (in case of solid bonding).

In the Inductive Effects tutorial, the Coil group option is mentioned as a means to mimic 
the effects of cross bonding, but the exact extent of the validity of this approach is not 
shown. In order to investigate the different bonding types more closely, the fifth tutorial 
considers three sections of cable individually, represented by three separate Magnetic 
Fields interfaces.

The model uses a strongly simplified geometry. Even so, the results correspond very well 
to those from the Inductive Effects tutorial. This justifies both the simplified geometry in 
this tutorial, as well as the cross-bonding approach suggested in the Inductive Effects 
tutorial. Finally, as opposed to the other inductive models in this series, this one allows for 
investigating dissimilar section lengths.

Included Topics
• Using the Magnetic Fields interface: Ampère’s Law, Coil, Magnetic Insulation... 

Connecting three finite element models in series, using an Electrical Circuit.

• Discussing several bonding types: single-point bonding, solid bonding, and cross 
bonding, and reflecting on how they affect the potential and currents in the screens.

• Validating if cross bonding can be modeled in 2D by means of a Coil group. Comparing 
the losses and lumped parameters to the detailed plain 2D model from the Inductive 
Effects tutorial and reflecting on what details are really important.
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S U B M A R I N E  C A B L E  6  —  T H E R M A L  E F F E C T S

Figure 7: The temperature distribution inside the cable at sea bed temperature Text = 20°C.

This tutorial uses the Inductive Effects model from this series as a basis and adds thermal 
effects, including a temperature dependent conductivity (through linearized resistivity). It 
shows how to achieve a multiphysics coupling between electromagnetic fields and heat 
transfer, using the frequency-stationary study type (induction heating).

The influence of elevated temperatures on losses in the phases, screens, and armor is 
investigated (verification is included). The obtained temperature values are used in the 
Inductive Effects 3D tutorial, to apply a first-order temperature correction in 3D. Finally, 
the tutorial demonstrates how to match the resulting AC resistance to the one given by 
the IEC series of standards.

Included Topics
• Using the Magnetic Fields interface, the Heat Transfer in Solids interface and the 

Electromagnetic Heating multiphysics coupling to model induction heating.

• Using linearized resistivity. Investigating resistive- and magnetic losses. Reflecting on 
the difference between current-driven and voltage-driven conductors, and how the 
heat affects the electromagnetic properties of the cable. Investigating the difference 
between the AC- and DC resistance, and the validity of stationary-electric reasoning.

• Using a global ODE to set a phase conductivity such that the cable’s AC resistance 
matches a certain specified (temperature-dependent) value.
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S U B M A R I N E  C A B L E  7  —  G E O M E T R Y  &  M E S H  3 D

Figure 8: The helically twisted, swept mesh in the phases, the screens, and the armor.

The Inductive Effects 3D tutorial requires quite a lot of preparation in terms of geometry 
handling and meshing. In fact, this is what oftentimes represents a major part of the efforts 
spent on large 3D FEM models (twisted cable models in particular). In order not to 
overlook these important topics, they are addressed in a separate tutorial.

The tutorial is organized in four sections. The first part configures the camera settings 
(ensuring the geometry, mesh, and plots render as intended). Then, the geometry 
sequence is added, together with the selections. Finally, the mesh is constructed. Some 
postprocessing is done to investigate the quality of the mesh.

Included Topics
• Using advanced geometry handling and meshing to optimize a 3D mesh to produce a 

high level of detail, while keeping the number of degrees of freedom (DOFs) low.

• Using highly anisotropic meshes. Combining Swept meshes, Free Tetrahedral meshes, 
and Boundary Layer meshes. Reflecting on the importance of conforming meshes for 
periodicity planes. Demonstrating how mesh conformity can be enforced and checked.

• Improving the accuracy of the model by compensating for geometric effects like slanted 
cuts and the truncation of circles (linear elements will convert them to polygons).

• Using predefined selections of geometric entities to automate the work flow.
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S U B M A R I N E  C A B L E  8  —  I N D U C T I V E  E F F E C T S  3 D

Figure 9: The volumetric loss density in the armor and the screens, for the case where a first-
order temperature correction has been applied.

This last tutorial intends to give a “final answer” to 3D cable modeling. It has been 
developed with feedback from several experts from within the industry, and is on a par with 
the latest research (2020) when considering both performance and level of detail. 
Validation is included: The behavior of the models is analyzed within the context of refs. 
[2, 4, 5, and 6], and the cable’s official specifications.

The tutorial is organized in five sections: First, the cable is modeled without twist and 
compared to the much more detailed 2D models. Then, the twist is added and the model 
is solved and verified a second time. A temperature correction is added in a third step and 
an experimental numerical stabilization method is demonstrated in a fourth step. The 
tutorial finishes by switching to a different kind of periodicity, reducing the size of the 
model a hundredfold while still providing a similar accuracy.

Included Topics
• The demonstration of a large (industrial scale) COMSOL model, including a highly 

optimized mesh, optimized solver settings, advanced postprocessing (with global 
evaluations, integrations, plots, and animations), and a detailed theoretical treatment of 
the observed physical phenomena — including references to recent numerical research.
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• Using the Magnetic Fields interface in 3D: Ampère’s Law, Coil, twisted Periodicity... 
Exiting a 3D inductive model by means of a Coil feature (with slanted cut), combined 
with a Coil Geometry Analysis preprocessing step.

• A demonstration of twisted periodicity and short-twisted periodicity, phase- and armor 
lay length, first- (and higher) order temperature corrections, and the analysis of resistive 
and magnetic losses in the phases, the screens, and the armor.

• A detailed comparison between the 3D twist models — with or without linearized 
resistivity included — and 2D/2.5D models (with or without induction heating).

• A detailed analysis of the longitudinal and transverse eddies forming in the armor wires, 
and the paths taken by the magnetic field lines as they encircle the phase conductors.

• A reflection on numerical stability and the demonstration of a numerical stabilization 
method that manages to improve the accuracy while keeping the solving time low.
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Modeling Instructions (Introduction Tutorial)

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 2D.

In this case, we will not select any physics. This will be done in subsequent tutorials, 
depending on the analysis performed.

2 Click Done.

G E O M E T R Y  1

At this point, there are two options. One is to go to section Appendix — Modeling 
Instructions (Geometry) in this tutorial and follow the instructions for building the 
geometry there. In case you have limited interest in manually building geometries in 
COMSOL (because you intend to use CAD software for example), there is a second 
option. The completed geometry sequence can be inserted from a file:

1 In the Geometry toolbar, click Insert Sequence and choose Insert Sequence.

2 Browse to the model’s Application Libraries folder and double-click the file 
submarine_cable_e_geom_sequence.mph.

3 In the Geometry toolbar, click Build All.

4 Click the Zoom Extents button in the Graphics toolbar.
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5 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

You now have built the geometry. This step coincides with the last instructions in section 
Appendix — Modeling Instructions (Geometry). You can continue by preparing some 
parameters and selections.

G L O B A L  D E F I N I T I O N S

Geometric Parameters 1
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, type Geometric Parameters 1 in the Label text 
field.

If you have inserted the geometry sequence from a file, you might be surprised the table 
is already populated. This is because the parameters necessary for building the geometry 
are imported automatically.

Geometric Parameters 2
1 In the Home toolbar, click Parameters and choose Add > Parameters.

2 In the Settings window for Parameters, type Geometric Parameters 2 in the Label text 
field.

3 Locate the Parameters section. Click Load from File.
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4 Browse to the model’s Application Libraries folder and double-click the file 
submarine_cable_b_geom_parameters.txt.

Eight items have been added to the table. The first is the main conductor’s true cross 
section, Acon; 500 mm2. Since these conductors are not actually solid but consist of a 
group of compacted strands, there is some space in between, and Acon is not identical 
to pi*(Dcon/2)^2 (the surface area implicitly used in the geometry). This gives rise to 
the parameter Ncon. Apbs is pretty straightforward. The last five parameters are related 
to the cable’s length.

D E F I N I T I O N S

Next add some selections to use later on, when assigning physics features for instance. 
Fifteen domain selections have already been defined by the geometry sequence (as shown 
at the end of this tutorial). Based on the geometry-induced selections, you can add four 
derived selections: two unions, a difference, and an adjacent selection.

Phases
1 In the Definitions toolbar, click Union.

2 In the Settings window for Union, type Phases in the Label text field.

3 Locate the Input Entities section. Under Selections to add, click Add.

4 In the Add dialog, in the Selections to add list, choose Phase 1, Phase 2, and Phase 3.

5 Click OK.

6 Click the Zoom to Selection button in the Graphics toolbar.

Metals
1 In the Definitions toolbar, click Union.

2 In the Settings window for Union, type Metals in the Label text field.

3 Locate the Input Entities section. Under Selections to add, click Add.
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4 In the Add dialog, in the Selections to add list, choose Phases, Screens, Steel Helix (Fiber), 
and Cable Armor.

5 Click OK.

6 Click the Zoom to Selection button in the Graphics toolbar.

By unifying the phase, screen, fiber and armor selections, you have just found an 
efficient strategy to determine the Metals selection. Notice that selecting the armor wires 
individually by hand, would have been kind of tedious and error prone. That is why the 
geometry sequence is used to generate the selection for the armor wires (the same 
operator in the geometry sequence that builds the wires, also defines their selection). 
For more details on this, see section Appendix — Modeling Instructions (Geometry).

Insulators (External to Phase)
1 In the Definitions toolbar, click Difference.

2 In the Settings window for Difference, type Insulators (External to Phase) in the 
Label text field.

3 Locate the Input Entities section. Under Selections to add, click Add.

4 In the Add dialog, select Cable Domains in the Selections to add list.

5 Click OK.

6 In the Settings window for Difference, locate the Input Entities section.

7 Under Selections to subtract, click Add.

8 In the Add dialog, in the Selections to subtract list, choose Metals, 
Semiconductive Compound, and Cross-Linked Polyethylene (XLPE).

9 Click OK.
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10 Click the Zoom to Selection button in the Graphics toolbar.

Air Pockets
1 In the Definitions toolbar, click Difference.

2 In the Settings window for Difference, type Air Pockets in the Label text field.

3 Locate the Input Entities section. Under Selections to add, click Add.

4 In the Add dialog, select Insulators (External to Phase) in the Selections to add list.

5 Click OK.

6 In the Settings window for Difference, locate the Input Entities section.

7 Under Selections to subtract, click Add.

8 In the Add dialog, in the Selections to subtract list, choose Polyethylene, Polypropylene, 
Fiber Optic Core, and Bitumen Compound.

9 Click OK.

10 Click the Zoom to Selection button in the Graphics toolbar.

Solid Domains
1 In the Definitions toolbar, click Difference.

2 In the Settings window for Difference, type Solid Domains in the Label text field.
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3 Locate the Input Entities section. Under Selections to add, click Add.

4 In the Add dialog, select Electromagnetic Domains in the Selections to add list.

5 Click OK.

6 In the Settings window for Difference, locate the Input Entities section.

7 Under Selections to subtract, click Add.

8 In the Add dialog, select Air Pockets in the Selections to subtract list.

9 Click OK.

10 Click the Zoom to Selection button in the Graphics toolbar.

Thermal Contact
1 In the Definitions toolbar, click Adjacent.

2 In the Settings window for Adjacent, type Thermal Contact in the Label text field.

3 Locate the Input Entities section. Under Input selections, click Add.

4 In the Add dialog, select Insulators (External to Phase) in the Input selections list.

5 Click OK.

6 In the Settings window for Adjacent, locate the Output Entities section.

7 Select the Interior boundaries checkbox.
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Now that the selections are finished, the materials will be next. To start with, you can 
modify the View to show the material colors. Then, the materials will be added, they will 
be given an appropriate label (if they do not already have it), a selection and an appearance. 
At the end of the instructions a table is listed that allows you to recheck the given settings.

View 1
1 In the Model Builder window, under Component 1 (comp1) > Definitions click View 1.

2 In the Settings window for View, locate the Colors section.

3 Select the Show material color and texture checkbox.

A D D  M A T E R I A L

1 In the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-in > Air.

4 Right-click and choose Add to Component 1 (comp1).

5 In the tree, select Built-in > Water, liquid.

6 Right-click and choose Add to Component 1 (comp1).

M A T E R I A L S

Air (mat1)
1 Click the Zoom to Selection button in the Graphics toolbar.

2 In the Model Builder window, under Component 1 (comp1) > Materials click Air (mat1).

The air is applied to all domains. This is a good thing. You can use it as a default material 
and override it with other materials where applicable.

Water, liquid (mat2)
1 In the Model Builder window, click Water, liquid (mat2).
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2 Select Domain 2 only.

3 Click the Zoom to Selection button in the Graphics toolbar.

Gravel, saturated
1 In the Model Builder window, right-click Materials and choose Blank Material.

2 In the Settings window for Material, type Gravel, saturated in the Label text field.

3 Select Domains 1 and 7 only.

4 Click the Zoom to Selection button in the Graphics toolbar.

5 Click to expand the Material Properties section. In the Material properties tree, select 
Basic Properties > Relative Permeability.

6 Click Add to Material.

7 Repeat these steps for Electrical Conductivity, Relative Permittivity, Thermal Conductivity, 
Density, and Heat Capacity at Constant Pressure.

8 Click to collapse the Material Properties section. Click to expand the Appearance section. 
From the Material type list, choose Rock.

Now, you have created a blank material with material properties for μr, σ, εr, k, ρ, and 
Cp; the material properties used for the electromagnetic and thermal equations 
respectively.
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In a typical modeling scenario you would add the physics first however, before setting up 
the materials. The physics will then automatically request the material properties required 
to make the model solve. Setting up the materials in detail without the physics included 
takes a bit more effort, but it comes with the advantage that subsequent tutorials within 
this series will have most of the material properties preincluded. This allows the rest of the 
tutorial series to focus on the material properties that are of special importance to the 
particular kind of analysis performed.

You can save some time by taking this blank material as a template, and duplicating it a 
number of times.

Polyethylene
1 Right-click Gravel, saturated and choose Duplicate.

2 In the Settings window for Material, type Polyethylene in the Label text field.

3 Locate the Geometric Entity Selection section. From the Selection list, choose 
Polyethylene.

4 Click the Zoom to Selection button in the Graphics toolbar.

5 Click to expand the Appearance section. From the Material type list, choose Oil.

(Admittedly, polyethylene is not “oil”, but the color seems suitable.)

Polypropylene
1 Right-click Polyethylene and choose Duplicate.

2 In the Settings window for Material, type Polypropylene in the Label text field.
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3 Locate the Geometric Entity Selection section. From the Selection list, choose 
Polypropylene.

4 Click to expand the Appearance section. From the Material type list, choose Plastic.

5 From the Color list, choose Gray.

Cross-linked polyethylene (XLPE)
1 Right-click Polypropylene and choose Duplicate.

2 In the Settings window for Material, type Cross-linked polyethylene (XLPE) in the 
Label text field.

3 Locate the Geometric Entity Selection section. From the Selection list, choose Cross-

Linked Polyethylene (XLPE).

4 Click to expand the Appearance section. From the Color list, choose White.

Semiconductive compound
1 Right-click Cross-linked polyethylene (XLPE) and choose Duplicate.

2 In the Settings window for Material, type Semiconductive compound in the Label text 
field.
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3 Locate the Geometric Entity Selection section. From the Selection list, choose 
Semiconductive Compound.

4 Click to expand the Appearance section. From the Color list, choose Black.

Bitumen compound
1 Right-click Semiconductive compound and choose Duplicate.

2 In the Settings window for Material, type Bitumen compound in the Label text field.

3 Locate the Geometric Entity Selection section. From the Selection list, choose 
Bitumen Compound.

The glass is readily available in the material library, you can add it as follows.

A D D  M A T E R I A L

1 Go to the Add Material window.

2 In the tree, select Built-in > Silica glass.

3 Right-click and choose Add to Component 1 (comp1).
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M A T E R I A L S

Silica glass (mat9)
1 In the Model Builder window, under Component 1 (comp1) > Materials click 

Silica glass (mat9).

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Fiber Optic Core.

4 Click the Zoom to Selection button in the Graphics toolbar.

Stainless steel
1 In the Model Builder window, under Component 1 (comp1) > Materials right-click 

Bitumen compound (mat8) and choose Duplicate (make sure to duplicate the bitumen, 
not the glass).

2 In the Settings window for Material, type Stainless steel in the Label text field.

3 Locate the Geometric Entity Selection section. From the Selection list, choose 
Steel Helix (Fiber).

4 Click to expand the Appearance section. From the Material type list, choose Steel.
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Copper
1 Right-click Stainless steel and choose Duplicate.

2 In the Settings window for Material, type Copper in the Label text field.

3 Locate the Geometric Entity Selection section. From the Selection list, choose Phases.

4 Click the Zoom to Selection button in the Graphics toolbar.

For the phases, the screens and the armor, we will investigate the effect of elevated 
temperatures on the cable’s electromagnetic properties in a fully coupled induction 
heating model (see the Thermal Effects tutorial). To this end, add linearized resistivity 
to the copper (and indirectly, to the lead and the steel).

5 Click to expand the Material Properties section. In the Material properties tree, select 
Electromagnetic Models > Linearized Resistivity.

6 Click Add to Material.

7 Click to collapse the Material Properties section. Click to expand the Appearance section. 
From the Material type list, choose Copper.

Lead
1 Right-click Copper and choose Duplicate.

2 In the Settings window for Material, type Lead in the Label text field.

3 Locate the Geometric Entity Selection section. From the Selection list, choose Screens.
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4 Click the Zoom to Selection button in the Graphics toolbar.

5 Click to expand the Appearance section. From the Material type list, choose Lead.

Galvanized steel
1 Right-click Lead and choose Duplicate.

2 In the Settings window for Material, type Galvanized steel in the Label text field.

3 Locate the Geometric Entity Selection section. From the Selection list, choose 
Cable Armor.

4 Click the Zoom to Selection button in the Graphics toolbar.

5 Click to expand the Appearance section. From the Material type list, choose Steel.

6 In the Materials toolbar, click Add Material to close the Add Material window.

Now that the materials are in place, it is a good practice to recheck their basic settings 
(as presented in the following table).
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7 In the Model Builder window, under Component 1 (comp1) > Materials, check whether the 
following materials are present:

Please see to it that the materials are actually put in Component 1 (comp1) > Materials, 
rather than Global Definitions > Materials.

M A T E R I A L S

What remains are the material properties. The properties that should be added are listed 
in the following table. Please check all of them for the correct value, even the ones that are 
already filled in. Note that for cases like this, a convenient option is to copy-paste the values 
directly from this *.pdf file to COMSOL.

Furthermore, note that material properties marked with an “x” are not used at all (they 
may be present, but their value is irrelevant). Material properties marked with a “-”, are 
deliberately left blank. They will be given a value in subsequent tutorials. Common 
practice is to include the unit when typing: “1e-14[S/m]”, although strictly speaking that 
should not be necessary in this case. The entire tutorial series assumes standard SI units.

Label Selection Appearance

mat1 Air All domains (partially 
overridden)

Air

mat2 Water, liquid Domain 2 Water

mat3 Gravel, saturated Domains 1 and 7 Concrete

mat4 Polyethylene Polyethylene Plastic

mat5 Polypropylene Polypropylene Plastic

mat6 Cross-linked 
polyethylene (XLPE)

Cross-Linked Polyethylene 
(XLPE)

Steel

mat7 Semiconductive 
compound

Semiconductive Compound Plastic

mat8 Bitumen compound Bitumen Compound Plastic

mat9 Silica glass Fiber Optic Core Custom

mat10 Stainless steel Steel Helix (Fiber) Steel

mat11 Copper Phases Copper

mat12 Lead Screens Lead

mat13 Galvanized steel Cable Armor Steel
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1 In the Model Builder window, under Component 1 (comp1) > Materials, add the following 
material properties:

M E S H  1

The last part of this tutorial consists of checking the mesh. COMSOL includes a whole 
range of tools for advanced meshing. In this case however, we are dealing with a 2D 
geometry of little to modest complexity: Even with a coarse mesh, the model will solve 
quite accurately. In the results, the difference between Extra fine and Coarse will show up 
somewhere in the 4th or 5th significant digit. Feel free to check this in subsequent 
tutorials.

So instead of spending time on intelligent mesh optimization schemes, we will choose a 
pragmatic approach and just use the element size setting Normal (the default).

mur sigma [S/m] epsr k [W/(m*K)] rho [kg/m^3] Cp [J/(kg*K)]

mat1 1 1e-14 1 k(T) rho(pA,T) Cp(T)

mat2 x x x k(T) rho(T) Cp(T)

mat3 1 1 28 1 2020 2512

mat4 1 1e-18 2.25 0.46 935 2302

mat5 1 1e-18 2.36 0.25 946 1920

mat6 1 1e-18 - 0.46 930 2302

mat7 1 2 2.25 10 1055 2405

mat8 1 3.2e-9 3.16 0.17 1062 1885

mat9 1 1e-14 3.75 1.38 2203 703

mat10 1 1.46e6 1 17.5 7920 475

mat11 - - 1 - 8940 385

mat12 - - 1 35.3 11340 127

mat13 - - 1 58 7850 475
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1 In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 
Build All.

This will be our mesh for the Capacitive, Inductive and Thermal Effects tutorials. it is 
more than fine enough to capture skin effects and small geometric features.

You have now completed this tutorial. The result is a COMSOL Multiphysics file with 
geometry, materials and mesh, that will be used as a template for a multitude of models 
investigating capacitive, inductive and thermal properties. Subsequent tutorials will refer 
to this file as submarine_cable_01_introduction.mph. The next tutorial in this series 
will include a detailed capacitive analysis.

1 From the File menu, choose Save As.

2 Browse to a suitable folder and type the filename 
submarine_cable_01_introduction.mph.
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Appendix — Modeling Instructions (Geometry)

The geometry in this tutorial series is based on parameters. This is not strictly necessary in 
COMSOL, rather it accommodates quick adjustments and keeps things consistent. Most 
of the parameters are based directly upon the mayor national or international standards (it 
is a standardized cable). This particular case is a 500 mm2, 220 kV cable. By adjusting the 
parameters, other types can easily be made. In order to speed up this part of the tutorial, 
the parameters will be loaded from a file.

G L O B A L  D E F I N I T I O N S

Geometric Parameters 1
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, type Geometric Parameters 1 in the Label text 
field.

3 Locate the Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
submarine_cable_a_geom_parameters.txt.

G E O M E T R Y  1

The geometry is constructed by means of a geometry sequence. The advantage of the 
sequence is that it not only saves the final result, but the entire process (the recipe, if you 
like). This way, it is easy to modify or parameterize the geometry. Additionally, some 
selections are being made. These selections will be used later on, when assigning material 
properties for instance.

You can start with the three phases. By setting their labels, and enabling the 
Resulting objects selection, you automatically set a domain selection that coincides with the 
shape you create. The selections will then propagate through the sequence (when a shape 
is copied, its selection will cover both the original and the copy). At the end of these 
modeling instructions, a blank material is created allowing you to check all geometry-
induced selections once more.

Phase 1
1 In the Geometry toolbar, click Circle.

2 In the Settings window for Circle, type Phase 1 in the Label text field.

3 Locate the Size and Shape section. In the Radius text field, type Dcon/2.

4 Locate the Position section. In the x text field, type -(Dpha/2)/sqrt(3).

5 In the y text field, type Dpha/2.
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6 Locate the Rotation Angle section. In the Rotation text field, type 120.

7 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
checkbox.

8 Click Build Selected.

9 Click the Zoom Extents button in the Graphics toolbar.

Phase 2
1 In the Geometry toolbar, click Circle.

2 In the Settings window for Circle, type Phase 2 in the Label text field.

3 Locate the Size and Shape section. In the Radius text field, type Dcon/2.

4 Locate the Position section. In the x text field, type Dpha/sqrt(3).

5 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
checkbox.

6 Click Build Selected.

7 Click the Zoom Extents button in the Graphics toolbar.

Phase 3
1 In the Geometry toolbar, click Circle.
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2 In the Settings window for Circle, type Phase 3 in the Label text field.

3 Locate the Size and Shape section. In the Radius text field, type Dcon/2.

4 Locate the Position section. In the x text field, type -(Dpha/2)/sqrt(3).

5 In the y text field, type -Dpha/2.

6 Locate the Rotation Angle section. In the Rotation text field, type -120.

7 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
checkbox.

8 Click Build Selected.

9 Click the Zoom Extents button in the Graphics toolbar.

Circle 4 (c4)
1 In the Geometry toolbar, click Circle.

2 In the Settings window for Circle, locate the Object Type section.

3 From the Type list, choose Curve.

4 Locate the Size and Shape section. In the Radius text field, type Dcon/2+Tscc.

5 Locate the Position section. In the x text field, type Dpha/sqrt(3).

6 Click to expand the Layers section. In the table, enter the following settings:

Layer name Thickness (m)

Layer 1 Tscc
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7 Click Build Selected.

Circle 5 (c5)
1 In the Geometry toolbar, click Circle.

2 In the Settings window for Circle, locate the Object Type section.

3 From the Type list, choose Curve.

4 Locate the Size and Shape section. In the Radius text field, type Dins/2-Tscc.

5 Locate the Position section. In the x text field, type Dpha/sqrt(3).

6 Locate the Layers section. In the table, enter the following settings:

7 Click Build Selected.

8 Click the Zoom Extents button in the Graphics toolbar.

Circle 6 (c6)
1 In the Geometry toolbar, click Circle.

2 In the Settings window for Circle, locate the Object Type section.

Layer name Thickness (m)

Layer 1 Tins
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3 From the Type list, choose Curve.

4 Locate the Size and Shape section. In the Radius text field, type Dins/2.

5 Locate the Position section. In the x text field, type Dpha/sqrt(3).

6 Locate the Layers section. In the table, enter the following settings:

7 Click Build Selected.

Circle 7 (c7)
1 In the Geometry toolbar, click Circle.

2 In the Settings window for Circle, locate the Object Type section.

3 From the Type list, choose Curve.

4 Locate the Size and Shape section. In the Radius text field, type Dins/2+Tpbs.

5 Locate the Position section. In the x text field, type Dpha/sqrt(3).

6 Locate the Layers section. In the table, enter the following settings:

Layer name Thickness (m)

Layer 1 Tscc

Layer name Thickness (m)

Layer 1 Tpbs
34 |  S U B M A R I N E  C A B L E  1  —  I N T R O D U C T I O N



7 Click Build Selected.

Semiconductive Compound
1 In the Geometry toolbar, click Booleans and Partitions and choose Union.

2 In the Settings window for Union, type Semiconductive Compound in the Label text 
field.

3 Select the objects c4 and c6 only.

4 Locate the Union section. Clear the Keep interior boundaries checkbox.

5 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
checkbox.
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6 Click Build Selected.

Cross-Linked Polyethylene (XLPE)
1 In the Geometry toolbar, click Booleans and Partitions and choose Union.

2 In the Settings window for Union, type Cross-Linked Polyethylene (XLPE) in the 
Label text field.

3 Select the object c5 only.

4 Locate the Union section. Clear the Keep interior boundaries checkbox.

5 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
checkbox.
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6 Click Build Selected.

Screens
1 In the Geometry toolbar, click Booleans and Partitions and choose Union.

2 In the Settings window for Union, type Screens in the Label text field.

3 Select the object c7 only.

4 Locate the Union section. Clear the Keep interior boundaries checkbox.

5 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
checkbox.
37 |  S U B M A R I N E  C A B L E  1  —  I N T R O D U C T I O N



6 Click Build Selected.

Next, will be the polyethylene parts. In order to simplify the geometry and accommodate 
meshing, a deliberate overlap between the circles is created (using a parameter called 
mfil). This avoids having infinitely narrow regions between circles touching. The 
sequence can be adjusted if necessary, to support a more complex combination of 
polymers.

Circle 8 (c8)
1 In the Geometry toolbar, click Circle.

2 In the Settings window for Circle, locate the Object Type section.

3 From the Type list, choose Curve.

4 Locate the Size and Shape section. In the Radius text field, type Dpha/2+mfil.

5 Locate the Position section. In the x text field, type Dpha/sqrt(3).

6 Locate the Layers section. In the table, enter the following settings:

7 Click Build Selected.

Layer name Thickness (m)

Layer 1 Tpe+mfil
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Circular Arc 1 (ca1)
1 In the Geometry toolbar, click More Primitives and choose Circular Arc.

2 In the Settings window for Circular Arc, locate the Radius section.

3 In the Radius text field, type Dpha3/2-mfil.

4 Locate the Angles section. In the Start angle text field, type -60.

5 In the End angle text field, type 60.

6 Click Build Selected.

7 Click the Zoom Extents button in the Graphics toolbar.

Rotate 1 (rot1)
1 In the Geometry toolbar, click Transforms and choose Rotate.

2 Select the objects c8, ca1, uni1, uni2, and uni3 only.

3 In the Settings window for Rotate, locate the Rotation section.

4 In the Angle text field, type 0[deg], 120[deg], 240[deg].

5 Click Build Selected.
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6 Click the Zoom Extents button in the Graphics toolbar.

Here, three different angles are used to create three copies of the same input objects 
(while propagating their selections).

Circle 9 (c9)
1 In the Geometry toolbar, click Circle.

2 In the Settings window for Circle, locate the Object Type section.

3 From the Type list, choose Curve.

4 Locate the Size and Shape section. In the Radius text field, type Dcab/2.

5 Locate the Layers section. In the table, enter the following settings:

Note that for longer expressions like this one, the easiest way to go, is to copy-paste them 
directly from this *.pdf file to COMSOL.

6 Click Build Selected.

7 Click the Zoom Extents button in the Graphics toolbar.

Layer name Thickness (m)

Layer 1 Dcab/2-(Dpha3/2-mfil)
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Circle 10 (c10)
1 In the Geometry toolbar, click Circle.

2 In the Settings window for Circle, locate the Object Type section.

3 From the Type list, choose Curve.

4 Locate the Size and Shape section. In the Radius text field, type Darm/2+Tarm/2+marm.

5 Locate the Layers section. In the table, enter the following settings:

6 Click Build Selected.

Polyethylene
1 In the Geometry toolbar, click Booleans and Partitions and choose Difference.

2 In the Settings window for Difference, type Polyethylene in the Label text field.

3 Select the objects c9, rot1(1), rot1(2), and rot1(3) only.

4 Locate the Difference section. Click to select the Activate Selection toggle button 
for Objects to subtract.

Layer name Thickness (m)

Layer 1 Tarm+2*marm
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5 Select the object c10 only.

6 Clear the Keep interior boundaries checkbox.

7 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
checkbox.

8 Click Build Selected.

You have now created the polyethylene parts. What is more, you have created a domain 
selection that refers to these parts. Next, let us have a look at the polypropylene parts.

Circle 11 (c11)
1 In the Geometry toolbar, click Circle.

2 In the Settings window for Circle, locate the Size and Shape section.

3 In the Radius text field, type Dpha*0.241335+mfil.
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4 Locate the Position section. In the x text field, type Dpha*-0.836015.

5 Click Build Selected.

Circle 12 (c12)
1 In the Geometry toolbar, click Circle.

2 In the Settings window for Circle, locate the Size and Shape section.

3 In the Radius text field, type Dpha*0.118595+mfil.

4 Locate the Position section. In the x text field, type Dpha*-0.890205.

5 In the y text field, type Dpha*-0.355815.

6 Click Build Selected.

Circle 13 (c13)
1 Right-click Circle 12 (c12) and choose Duplicate.

2 In the Settings window for Circle, locate the Position section.

3 In the y text field, type Dpha*0.355815, that is, remove the minus sign.

4 Click Build Selected.

Perhaps you are wondering about the numbers used here. These are the result of 
geometrical expressions that make the circles fit (apart from the overlap margin used). 
The size and position of the circles scale with Dpha, and the expressions have been 
simplified accordingly.

Rotate 2 (rot2)
1 In the Geometry toolbar, click Transforms and choose Rotate.

2 Select the objects c11, c12, and c13 only.

3 In the Settings window for Rotate, locate the Rotation section.

4 In the Angle text field, type 0[deg], 120[deg], 240[deg].
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5 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
checkbox.

6 From the Show in physics list, choose Off.

7 Click Build Selected.

Circle 14 (c14)
1 In the Geometry toolbar, click Circle.

2 In the Settings window for Circle, locate the Size and Shape section.

3 In the Radius text field, type Dpha*(1/sqrt(3)-1/2)+mfil.

4 Click Build Selected.

The selection for Rotate 2 is not shown in the physics, because it is only meaningful within 
the geometry sequence itself (it is used in Difference 2). The polypropylene domains are 
now created by taking the result from Rotate 2 and c14, and subtracting a hole for the fiber, 
together with a copy of the polyethylene.

Circle 15 (c15)
1 In the Geometry toolbar, click Circle.

2 In the Settings window for Circle, locate the Size and Shape section.
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3 In the Radius text field, type Dfic/2+Tfih.

4 Locate the Position section. In the x text field, type Dpha*-0.836015.

5 Click Build Selected.

Copy 1 (copy1)
1 In the Geometry toolbar, click Transforms and choose Copy.

2 In the Settings window for Copy, locate the Input section.

3 From the Input objects list, choose Polyethylene.

4 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
checkbox.

5 From the Show in physics list, choose Off.

6 Click Build Selected.

Polypropylene
1 In the Geometry toolbar, click Booleans and Partitions and choose Difference.

2 In the Settings window for Difference, type Polypropylene in the Label text field.

3 Locate the Difference section. From the Objects to add list, choose Rotate 2.
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4 In addition to Rotate 2, select the object c14; the center filler domain.

5 Click to select the Activate Selection toggle button for Objects to subtract.

6 From the Objects to subtract list, choose Copy 1.

7 In addition to Copy 1, select the object c15; the small hole for the fiber on the left.

8 Clear the Keep interior boundaries checkbox.

9 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
checkbox.
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10 Click Build Selected.

Now that the polypropylene filler material is complete, let us add some details for the fiber. 
Although a single circle object would suffice, the helix and the core are made as separate 
objects. This will result in two separate geometry-induced material selections.

Circle 16 (c16)
1 In the Geometry toolbar, click Circle.

2 In the Settings window for Circle, locate the Object Type section.

3 From the Type list, choose Curve.

4 Locate the Size and Shape section. In the Radius text field, type Dfib/2.

5 Locate the Position section. In the x text field, type Dpha*-0.836015.

6 Click Build Selected.
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Steel Helix (Fiber)
1 In the Geometry toolbar, click Circle.

2 In the Settings window for Circle, type Steel Helix (Fiber) in the Label text field.

3 Locate the Object Type section. From the Type list, choose Curve.

4 Locate the Size and Shape section. In the Radius text field, type Dfic/2+Tfih.

5 Locate the Position section. In the x text field, type Dpha*-0.836015.

6 Locate the Layers section. In the table, enter the following settings:

7 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
checkbox.

8 Click Build Selected.

Fiber Optic Core
1 In the Geometry toolbar, click Circle.

2 In the Settings window for Circle, type Fiber Optic Core in the Label text field.

3 Locate the Size and Shape section. In the Radius text field, type Dfic/2.

4 Locate the Position section. In the x text field, type Dpha*-0.836015.

5 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
checkbox.

Layer name Thickness (m)

Layer 1 Tfih
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6 Click Build Selected.

Next, are the armor wires. For the armor, we have the restriction that there should be an 
integer amount of wires in the cable’s circumference. This number, Narm, is limited by the 
armor wire’s diameter, and the overall size of the cable. Using the Rotate transform and 
the range() operator, the wires are equally distributed in the interval [0,360] degrees. In-
between the armor wires, some space is left open to allow for electric insulation and a low 
permeability gap for the magnetic flux density.

Cable Armor
1 In the Geometry toolbar, click Circle.

2 In the Settings window for Circle, type Cable Armor in the Label text field.

3 Locate the Size and Shape section. In the Radius text field, type Tarm/2.

4 Locate the Position section. In the x text field, type Darm/2.

5 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
checkbox.

6 Click Build Selected.

Rotate 3 (rot3)
1 In the Geometry toolbar, click Transforms and choose Rotate.
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2 In the Settings window for Rotate, locate the Input section.

3 From the Input objects list, choose Cable Armor.

4 In the Settings window for Rotate, locate the Rotation section.

5 In the Angle text field, type 360[deg]*range(1/Narm,1/Narm,1).

6 Click Build Selected.

This finishes the cable armor. The domain for the bitumen compound is now created by 
duplicating object c10, and subtracting from that, a copy of the armor.

Circle 20 (c20)
1 In the Model Builder window, under Component 1 (comp1) > Geometry 1 right-click 

Circle 10 (c10) and choose Duplicate.

2 In the Settings window for Circle, locate the Selections of Resulting Entities section.
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3 Select the Resulting objects selection checkbox.

4 From the Show in physics list, choose Off.

5 Click Build Selected.

Copy 2 (copy2)
1 In the Geometry toolbar, click Transforms and choose Copy.

2 In the Settings window for Copy, locate the Input section.

3 From the Input objects list, choose Cable Armor.

4 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
checkbox.

5 From the Show in physics list, choose Off.
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6 Click Build Selected.

Bitumen Compound
1 In the Geometry toolbar, click Booleans and Partitions and choose Difference.

2 In the Settings window for Difference, type Bitumen Compound in the Label text field.

3 Locate the Difference section. From the Objects to add list, choose Circle 20.

4 Click to select the Activate Selection toggle button for Objects to subtract.

5 From the Objects to subtract list, choose Copy 2.

6 Clear the Keep interior boundaries checkbox.

7 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
checkbox.
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8 Click Build Selected.

Now that the bitumen is finished, add a circle that covers the whole cable. This is primarily 
to get the Cable Domains selection.

Cable Domains
1 In the Geometry toolbar, click Circle.

2 In the Settings window for Circle, type Cable Domains in the Label text field.

3 Locate the Size and Shape section. In the Radius text field, type Dcab/2.

4 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
checkbox.
53 |  S U B M A R I N E  C A B L E  1  —  I N T R O D U C T I O N



5 Click Build Selected.

What remains are the domains exterior to the cable. Part of this, is the circle that covers 
the electromagnetic domains. Outside this circle, you will only be solving for heat transfer 
(electromagnetic fields are assumed to have dropped to zero). Rectangular domains are 
added for the sea bed and the water.

Electromagnetic Domains
1 In the Geometry toolbar, click Circle.

2 In the Settings window for Circle, type Electromagnetic Domains in the Label text 
field.

3 Locate the Size and Shape section. In the Radius text field, type 5*Dcab/2.

4 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
checkbox.

5 Click Build Selected.
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6 Click the Zoom Extents button in the Graphics toolbar.

Thermal Domains
1 In the Geometry toolbar, click Rectangle.

2 In the Settings window for Rectangle, type Thermal Domains in the Label text field.

3 Locate the Size and Shape section. In the Width text field, type 10[m].

4 In the Height text field, type 8[m].

5 Locate the Position section. In the x text field, type -5[m].

6 In the y text field, type -4[m].

7 Click to expand the Layers section. In the table, enter the following settings:

8 Locate the Selections of Resulting Entities section. Select the Resulting objects selection 
checkbox.

9 Click Build Selected.

Layer name Thickness (m)

Layer 1 5[m]
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10 Click the Zoom Extents button in the Graphics toolbar.

This completes the geometry. Notice that the size of the rectangle does not depend on 
the cable’s parameters. A wise choice for the size of the thermal domains strongly 
depends on the thermal properties and conditions. For a discussion on this, see the 
Thermal Effects tutorial.

Before finishing, feel free to check that the geometry-induced selections exists, and are 
according to your expectations. You can do so by adding a blank material.

M A T E R I A L S

Material 1 (mat1)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, locate the Geometric Entity Selection section.

3 From the Selection list, choose Thermal Domains.
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4 Click the Zoom to Selection button in the Graphics toolbar.

5 From the Selection list, choose Electromagnetic Domains.

6 Click the Zoom to Selection button in the Graphics toolbar.

7 From the Selection list, choose Cable Domains.
57 |  S U B M A R I N E  C A B L E  1  —  I N T R O D U C T I O N



8 Click the Zoom to Selection button in the Graphics toolbar.

9 From the Selection list, choose Bitumen Compound.
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10 From the Selection list, choose Cable Armor.

11 From the Selection list, choose Fiber Optic Core.
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12 From the Selection list, choose Steel Helix (Fiber).

13 From the Selection list, choose Polypropylene.
60 |  S U B M A R I N E  C A B L E  1  —  I N T R O D U C T I O N



14 From the Selection list, choose Polyethylene.

15 From the Selection list, choose Screens.
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16 From the Selection list, choose Cross-Linked Polyethylene (XLPE).

17 From the Selection list, choose Semiconductive Compound.
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18 From the Selection list, choose Phase 3.

19 From the Selection list, choose Phase 2.
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20 From the Selection list, choose Phase 1.

If anything seems out of order, please retrace your steps. Alternatively, check out the 
completed geometry sequence included in this tutorial series as a reference 
(submarine_cable_e_geom_sequence.mph).

21 Right-click Material 1 (mat1) and choose Delete.
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